
Lowering certain prognostic markers has been shown to reduce risk and  
improve survival in patients with PBC.1,2,*,† 

Your EHR/EMR system can be used to help you evaluate your patients with PBC. 

IS IT TIME TO CONSIDER THE NEXT 
STEP FOR YOUR PATIENTS WITH PBC?
Have you reviewed prognostic markers 
for your patients with PBC recently?

▪ �Pull a list report in the EHR/EMR system to help identify 
your patients with PBC and evaluate their response to 
pharmacological treatment. Criteria to review include4,5:

Identify your patients with PBC (ICD-10 Code K74.33,‡)

The Global PBC 
Study Group|| 
suggests these 
updated prognostic 
markers be 
considered1,2:

- �The optimal 
threshold for ALP is 
≤1 x ULN*

- �The optimal 
threshold for bilirubin 
is ≤0.6 x ULN*

- �Regular assessment 
of fibrosis stage†

Age Current medications

Gender Date of last office visit

Date of PBC diagnosis TE/MRE

Last 3 laboratory results for the following:

• ALP§ 
• ALT§ 
• AST§

• GGT§

• Total bilirubin§

• Albumin§

• Platelet count

ALP, alkaline phosphatase; ALT, alanine aminotransferase; AST, aspartate aminotransferase; EHR, electronic health record; EMR, electronic medical record; 
GGT, gamma-glutamyltranspeptidase; ICD-10, Internal Classification of Diseases, 10th Revision; MRE, magnetic resonance elastography; PBC, primary biliary 
cholangitis; TE, transient elastography; UDCA, ursodeoxycholic acid; ULN, upper limit of normal.

*�The Global PBC Study Group conducted an analysis including UDCA-treated and untreated patients diagnosed with PBC (N=3,059) with bilirubin levels ≤1x 
ULN at baseline or at 1 year. The study explored optimal thresholds of bilirubin and ALP to predict liver transplantation or death. The association of ALP 
with survival was assessed in a subgroup of UDCA-treated patients with ALP ≤1.67 x ULN and normal bilirubin at 1 year.1

†�Data from the Global PBC Study Group were used, and this analysis included UDCA‐treated patients in whom a liver biopsy was performed at study entry in 
order to evaluate the utility of baseline fibrosis stage in predicting long-term outcomes in the context of biochemical risk stratification. Biopsies conducted 
in the 24 months prior to study entry and up to 12 months after study entry were considered baseline.2

‡�For patients in your practice diagnosed with PBC prior to September 2015, you may need to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6
§�Obtain ULN for these parameters from the laboratory in which patient had blood drawn, as guidelines-based treatment decisions are based on whether 
these parameters exceed a laboratory ULN.

||�The Global PBC Study Group is an international collaboration of 17 centers across Europe and North America that aims to identify reliable surrogate 
endpoints in PBC using patient data from long-term follow-up cohorts.1,2
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  �Consider performing EHR/
EMR pulls regularly in patients 
with PBC. AASLD guidelines 
recommend routine monitoring 
of liver tests every 3 to 6 
months5

  �Regularly assess patients’ 
fibrosis stage2,4

  �Evaluate patient records before each 
appointment to determine if optimal 
thresholds are being met

  �Consider GLOBE or UK-PBC scoring 
systems, based on continuous 
laboratory variables, to assess 
prognosis after initiation of UDCA4,5

AASLD, American Association for the Study of Liver Diseases; CBC, complete blood count; EHR, electronic health record; EMR, electronic medical record; 
ICD-10, International Classification of Diseases, 10th Revision; INR, international normalized ratio; LDL-C, low-density lipoprotein cholesterol; TSH, thyroid 
stimulating hormone; UDCA, ursodeoxycholic acid. 
¶May refer to liver-related ICD-10 codes, such as ascites, esophageal varices, portal hypertension, or cirrhosis.4,5

References: 1. Murillo Perez CF, Harms MH, Lindor KD, et al; the GLOBAL PBC Study Group. Goals of treatment for improved survival in primary biliary 
cholangitis: treatment target should be bilirubin within the normal range and normalization of alkaline phosphatase. Am J Gastroenterol. 2020;115(7):1066-
1074. 2. Murillo Perez CF, Hirschfield GM, Corpechot C, et al; the GLOBAL PBC Study Group. Fibrosis stage is an independent predictor of outcome in 
primary biliary cholangitis despite biochemical treatment response. Aliment Pharmacol Ther. 2019;50(10):1127-1136. 3. 2022 ICD-10-CM Diagnosis Code K74.3. 
ICD10Data.com Website. https://www.icd10data.com/ICD10CM/Codes/K00-K95/K70-K77/K74-/K74.3. Accessed January 17, 2022. 4. Younossi ZM, Bernstein D, 
Shiffman ML, et al. Diagnosis and management of primary biliary cholangitis. Am J Gastroenterol. 2019;114(1):48-63. 5. Lindor KD, Bowlus CL, Boyer J, Levy C, 
Mayo M. Primary biliary cholangitis: 2018 practice guidance from the American Association for the Study of Liver Diseases. Hepatology. 2019;69(1):394-419.  
6. 2013 ICD-9-CM Diagnosis Code 571.6. ICD9Data.com Website. http://www.icd9data.com/2013/Volume1/520-579/570-579/571/571.6.htm. Accessed January 
17, 2022.

Create PBC-monitoring routines using your EHR/EMR system 

▪ Review liver-related decompensation events/hospitalization in the last year4,5,¶

▪ Review additional tests and laboratory results, including4,5:

▪ �Review clinical considerations such as pruritus, fatigue, Sicca syndrome, family 
screening, liver-related decompensation events, comorbid autoimmune diseases,  
or hyperlipidemia4,5

Assess other factors important in overall PBC management

TSH

Bone mineral densitometry

Liver ultrasound 

LDL-C 

Vitamins A, D, E, and K

INR

Upper endoscopy

CBC
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The next few pages provide step-by-step instructions on how to run a patient 
report based on condition (ICD-10 code) for common EHR/EMR systems:  

IDENTIFYING PATIENTS WITH PRIMARY BILIARY 
CHOLANGITIS IN YOUR EHR/EMR SYSTEM WITH ICD-10 
CODE K74.3*

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 

Allscripts TW
(version 19.4)

Allscripts TW
Admin Automating Scheduled Query

(version 19.4)

Allscripts TW
Admin Patient List Menu

(version 19.4)

Allscripts TW
End User Patient List Query

(version 19.4)

Allscripts TW
End User Patient Lists

(version 20.1)

athenaOne
(version 22.7)

Cerner RW
Report Writers

 (version 2018.08.05)

Cerner
 (version 2018.08.05)

eClinicalWorks
(version 11.52.75.6)

EpicCare Ambulatory
(version May 2022)

GE Centricity
(version 9.8-12.x)

gMed-gGastro
(version v5.r1.1)

Greenway Intergy
(version 12.50.00.03)

Greenway PrimeSuite
(version 18.00.02.06)

McKesson Practice Partner
(version 11.4)

NextGen 
(version 6.2021)

Meditech Expanse 
(Service Release 13)

Practice Fusion 
(version 3.72)
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TouchWorks (TW) has several workflow options to create and run patient lists. This workflow is based upon the TW 
admin creating the Patient List and exporting that completed list to the user.

1. �Under the VTB (Vertical Toolbar), click on TW Admin. 
2. �Click on the Patient Query menu item. 
3. �Select the Manage Queries button, located at the bottom 

left. (A new box will open.)  
4. �Create a name for the new Query in the New Query 

Name box and click on the Green Plus icon. (A new box 
will open to add logic to the new query.)

5. �Select Diagnosis from the Options menu. 
6.  �Select ICD-10 from the Select an Option drop-down 

menu.
7.  �Add the ICD-10 Code K74.3 into the search box and click 

on the Search button.
8.  �The K74.3 code now appears in the Search Results box. 

Click on the right pointed arrow to move the selection 
K74.3 to the Current Selection box.

9.  �Set Diagnosis Status to Active.
10.  �Add a date range using the drop-down to the right of 

the Active status. 
11.  �Set the Date Range filter content fields as desired: Field 

one: choose Desired Relationship; Field two: select 
the Desired Numerical Value; field three: select your 
Preferred Time Frame (e.g., Field one: In Past. Field 
two: 2. Field three: Years. Result: In Past 2 Years.).

12.  �Set Include/Exclude to Include. Click OK.
13.  �Click on Save and Return located at the bottom of the 

Options menu, under the Query Actions header. (You 
will now be returned to the query list.)

14.  �Locate the new query and click the Run Query icon.  
NOTE: Depending on the amount of data returned, this could 
take some time to complete.

15.  �Query Started Successfully pop-up box will appear. 
Click OK.

16.  �Query results will be displayed in the Query History and 
Results panel to the right. 

17.  �Once the query has completed, click on the Magnifying 
Glass icon located just to the left of the query Started 
On date in the Query History and Results panel. (This 
will open the Query Result View window.) 

18.  �In the drop-down box Profile, select the desired profile 
NOTE: If you have not yet created a profile, follow the steps in 
the box below. (The profile determines the fields that will be 
displayed in your report.)

19.  �Click on the Start Patient List Export icon located to 
the left of the Add Profile icon.

20.  �Click on the Refresh icon until the Card File icon 
appears by your query.

21.  �Click on the Card File icon.
22.  �Report is now available in the Exported Data window
23.  �Click on the Select /Unselect All icon in the upper 

right-hand corner to select all columns to be included 
in the report.  
NOTE: A max of 10 columns can be selected for the PDF option.

24.  �Report can now be exported to either Excel or PDF 
format by clicking on one of the corresponding icons, 
located in the upper right-hand corner.

25.  �Once the export option is selected, the View and Track 
Your Download window will be displayed. 

26.  �From View and Track Your Downloads click on the Save 
button to save the report to the PC’s default download 
folder, or click on the Black Drop-Down Arrow and 
select Save As to choose a preferred save location.

NOTE: If you do not already have a profile created, you will need to complete the following steps:
1.  �From the Query Result view, click on the green circle with the white plus sign icon to create a profile and select 

all the fields that apply. The available Profile items include: 
First Name, Last Name, Date of Birth, Zip Code, State, Gender, Address 1, Address 2, City, MRN, Home Phone, PCP 
Patient Header, Preferred Communication

2.  �Type in a profile name.
3.  �Click Apply. This profile will then appear on your drop-down list in the Export Profile field.

Allscripts Customer Service
800-877-5678

Allscripts Touchworks
(version 19.4)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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TW has several workflow options to create and run patient lists. This workflow is based 
upon the TW admin creating an automated patient list query which the end users can 
access within TW.

1. �Automating the Query (Must have TW Admin privileges):
	 a. �From TW Admin menu, click on the Patient Query.
	 b. �Click on the Manage Queries button, located at the bottom left. The Launcher 

window opens.
	 c. �Locate desired query (reference Tip Sheet when creating a PBC Patient List for 

Report Writers TW)
	 d. �Click on the Calendar icon (Schedule Query Run) by the desired query. The Patient 

Query Schedule – Patient Query Scheduler window will open. 
NOTE: To see Calendar name, Schedule query run and then hover your mouse over the calendar icon.

	 e. �In the Time & Duration box, set the Start Time and Start Date.
	 f. �Select End Date? if desired.
	 g. �In the Recurrence Pattern panel, select recurrence, (i.e., Once, Daily, Weekly, 

Monthly and the corresponding schedule for that recurrence), (e.g., for monthly, 
select the First Monday of Every Month).

	 h. �Click the Add Schedule button. 
	 i. �Click Close Window.
	 j. �Click the Return to EHR button located in upper right-hand corner. This takes you 

to the Patient Query main page. 

2. �Create an Action Set (Must have TW Admin privileges):  
NOTE: This is how TW sends the automated query from the admin area to the location where end users 
can access the query. 

	 a. �In the Patient Query area, locate and select the automated query from above.
	 b. �Click the New button. It will take you to the Add/Edit Action Set tab.
	 c. �In the Action Set Property tab, you can add a description of the report in the 

Patient Action Description text box, (e.g., PBC patient list monthly report).
	 d. �Under the Action Set Properties tab, check the Replace Existing box.
	 e. �Click Save.

Allscripts Customer Service
800-877-5678

Allscripts TouchWorks 
Admin Automating Scheduled Query

(version 19.4)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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TW has several workflow options to create and run patient lists. This workflow provides step-by-step instructions for 
the TW admin to add a Patient List menu to the HTB and to assign users so they can easily access automated Patient 
List queries from their TW workplace. 

NOTE: Proceed with extreme caution while working in the TW “Admin” section as clicking on or inadvertently removing/
changing a setting can make TW inaccessible to all users. 

1. �Identifying the correct toolbar to add the Patient List 
menu  
When adding a new menu item to the HTB, it will be 
necessary to identify the name of the tool bar you will be 
modifying. Since these names can be nondescriptive and 
unique to each organization, following the steps below 
will help you locate the correct toolbar in the TW Admin 
section. 

	 a. �Open a patient chart and select the workplace that 
displays the HTB where you wish to add the Patient 
List menu. 
NOTE: Once you have the appropriate workplace in context, 
take a screen shot of the HTB and workplace for later 
reference.

	 b. �The HTB name should be similar to the workplace 
name (e.g., Workplace name = Provider and HTB name 
= ProvChartHTB).  

	 c. �In the above example, you would locate and select the 
ProvChartHTB in the Admin>Menu area and make sure 
the HTB menu items match your screenshot of the 
provider workplace HTB menu.

	 d. �Once you have identified the correct HTB menu, you 
can now add the new Patient List menu item.

2. �Adding the Patient List menu item to the TW HTB
	 a. �From the vertical toolbar (VTB), click on the VTB drop 

down-menu and select the Admin item.
	 b. �Select the Menus item from the Admin menu list.
	 c. �In the Product: field drop-down menu, select 

TouchWorksEHR.
	 d. �In the Type: field drop-down menu, select HTB.
	 e. �In the upper right-hand corner, click on the Search 

button.  A list of all HTBs will be displayed. 
	 f. �Locate the desired HTB name within the returned list 

(i.e., ProvChartHTB). 
	 g. �In the ID name field, click on the hyperlink of the 

named tool bar where you wish to add the Patient List 
menu. Menu Items are then displayed. 

	 h. �In the Menu Items section, under the column caption, 
ensure that the display matches the list of HTB menu 
items from your screenshot in 1a.

	 i. �Click on the Menu Items tab at the top. Determine 
where you want the new menu to display on the HTB.

	 j. �Click on the Insert button to add the Patient List 
menu.  
NOTE: the Patient List menu will be placed directly above the 
Insert button you selected.

	 k. �Once you click Insert, a text field will appear. Click on 
the Ellipsis (…) in the square button beside this text 
field. The Select Document window opens.

	 l. �In the Caption field, type the name of the menu item 
(e.g., Patient List) into the Caption field and click 
Search.

	 m. �In the ID column, click on the hyperlink Patient List. 
This will insert the Patient List link into the desired 
workplace on the HTB. 

	 n. �Click on Save located in the upper right-hand corner. 
	 o. �Validate your work by returning to the desired 

workplace and ensure that the Patient List menu item 
now displays on the desired HTB. 

3. �Assigning a Patient List to a TW user
	 a. Select Patient List Admin from the VTB.
	 b. Select the Manage Lists tab from the HTB.
	 c. �Click on the All button. The Users search window will 

open.
	 d. �Type the first and last name of the user in the Search 

For: field using the following format: Smith,A.
	 e. �Click on the Magnifying Glass icon to the right of the 

search box.
	 f. �Double click on the user’s name in the Users Search 

box.
	 g. �Click on the green Go icon to the right of the Available 

Lists: search box to display a list of available patient 
lists. 
NOTE: If you know the exact name of the Patient List you are 
searching for, you can enter that name in the Available Lists: 
search field and click on the green Go icon to return just that 
specific list.

	 h. �Highlight the desired Patient List name in the 
Available Lists box and click on Add To My Lists 
located in the lower right hand corner.

	 i. �The Patient List menu item will now be available in the 
user’s Patient List drop-down menu.

Allscripts Customer Service
800-877-5678

Allscripts TouchWorks 
Admin Patient List Menu

(version 19.4)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Open your TW workplace.

2. �Click on the Patient List menu on the horizontal tool bar (HTB). The Patient List 
window will be displayed. 
NOTE: If you do not find the Patient List menu item on your HTB, you will need to request that your TW 
admin add that for you.

3. �Click on the List: drop-down menu to view available patient lists.

4. �Select the desired list. A list of patients that meet the report criteria will be 
displayed.

5. �Double click on any patient in the list to go to their chart.

6. �From this view you can Print list or Export list or access the Patient Chart from the 
buttons at the bottom. You can also Remove patients from the list or Assign tasks 
related to a patient using the buttons at the bottom of the screen. 
NOTE: There are two filter options available in the Patient List user area. 
Date filter: In the event that the Patient List currently in context has multiple report dates, the user can 
use this filter to search for patients within a specific date range. The filter options include Start and End 
date range filters. 
Patient filter: This filter provides the user the ability to search for a specific patient. You can search by 
either Name or MRN from the drop down menu.

Allscripts Customer Service
800-877-5678

Allscripts TouchWorks 
End User Patient List Query

(version 19.4)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 



8

TW has several workflow options to create and run patient lists. This workflow provides step-by-
step instructions for the end user to add the Patient Lists (Pt Lists) menu item to their Action 
Bar. It also provides instructions for the TW Admin to assign a specific patient list to a user. This 
will allow the end user to easily access automated patient list queries.

Instructions for the end user to configure the 
Pt List menu item to appear in the Action Bar.

TW now provides end users the ability to show 
or hide some menu items, including Pt Lists.

	1.	From the Action Bar, select Site Map.

	2.	Select the TW tab.

	3.	�Click on the three dots icon to the right of 
Pt Lists in the MAIN submenu.

	4.	�Select Show in Menu. 
NOTE: Proceed with extreme caution while 
working in the TW Administration section as 
clicking on or inadvertently removing/changing a 
setting can make TouchWorks inaccessible to all 
users. 

Instructions for the TW Admin to assign a 
patient list to a TouchWorks user.

Only the TW Admin has the ability to add or 
remove a user’s access to specific patient lists.

	1.	Navigate to the Site Map.

	2.	Select the TW tab.

	3.	�In the Utilities submenu, select Pt Lists – 
Manage.

	4.	�In the For: dropdown box, select the desired 
user. 
NOTE: If the user does not appear in the For: 
dropdown box, click the blue ALL button to 
search for the desired user. The Users window 
will display. Type the last name (or last name, 
first name) of the user in the Search for User… 
box. Then click the Search button. Select the 
desired user. Then click the green OK button in 
the lower right.

	5.	�In the Available Lists box, type the full 
name or partial name of the Pt List you 
want or leave the field blank. The results 
box will display those lists that begin with 
the characters you entered. 
NOTE: If are not certain of the name or the 
spelling of the Pt List you want, type a % and 
then a partial name. The search will then return 
all lists that contain the characters you entered.

	6.	Click the Go button.

	7.	�Select the desired Pt List from the results 
box.

	8.	�Click the Add To My Lists button. The Pt List 
menu item will now be available in the List 
dropdown in the user’s Pt Lists workspace.

Allscripts Customer Service
800-877-5678

Allscripts TouchWorks 
End User Patient Lists

(version 20.1)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �From athenaOne, click Reports in the purple menu bar. Select Report Builder. 
NOTE: If Report Builder is not visible, contact your administrator for the appropriate user permissions.

2. �Select Report Type: Clinicals-Encounters. Select Next (at the bottom of the page).

3. �Select the following Display Columns:
· �Clinical Encounter Date
· �Diagnosis Code with Description
· �Patient ID
· �Patient Name

Use the arrows or double click to move the selected parameters from the left pane 
to the right pane. Use the magnifying glass to find additional parameters, if needed. 
Additional display columns can be chosen, if desired.

4. �Click Next. 

5. �Select the following Filters:
· �ICD-10 Encounter Diagnosis Code
· �Clinical Encounter Date

Use the arrows or double click to move the selected parameters from the left pane 
to the right pane. Use the magnifying glass to find additional parameters, if needed.

6. �In the Filter Criteria, select either a Fixed Date Range or a Relative Date Range. 
Under Diagnosis Code, type: ICD-10 code K743 (no period).

7. �You can now Preview the report or select Run Report. Select desired Output Method. 
Click OK.

8. �Select Save Report. Enter an appropriate name for your report. Select Clinicals to file 
the report. You can then find this report in your Report Library under your Clinicals 
tab.

Athena Customer Support
800-981-5084

athenaOne
(version 22.7)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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Generating a report through Discern 
Reporting Portal 
1. �Click the Menu dropdown on your 

PowerChart/SurgiNet/FirstNet toolbar to 
open the Discern Reporting Portal.  
NOTE: If you work from the AppBar, go to First-
time Setup: Adding Icon to Your AppBar. The icon 
is also available on the Cerner Launch page. 

2. �Search for the report in Discern 
Reporting Portal by Name or by 
Category.  
NOTE: A list of reports will display. Reports can 
be selected by the source and/or categories. The 
categories will help assist you with narrowing 
down your report by selecting the appropriate 
folders. Scroll to see the different reports 
available using the numbers and/or arrows to 
change the page. 

3. �Click the name of your desired report 
(e.g., Primary Biliary Cholangitis Report/
ICD-10 Code K74.3), to see additional 
information. 

4. �Click Run.  
NOTE: For all reports, follow the prompts and 
fill in the appropriate Date/Date Ranges in the 
Report Fields. 

5. �Add the Location at the prompt and 
click Execute. 

6. �After the data is displayed on the 
screen, you save the output by clicking 
on the Save icon (floppy disc). 

7. �Name the file and select the location in 
your files where you would like to save 
it and click Save. 

Generating a report through BI Launch 
Pad 

1. �Open BI Launch Pad application from 
the AppBar.

2. �Click on Documents, then Folders. 

3. �Click on the + (sign) to expand Public 
Folders. 

4. �Select the folder where the report is 
saved. 

5. �Locate the desired report (e.g., Primary 
Biliary Cholangitis Report/ICD-10 Code 
K74.3), and double click on it. 

6. �Choose the Scheduling Location 
(department) and click OK for the report 
to run. 

7. �To export the report to PDF or Excel, 
click on the Export icon, choose the File 
Type, and click OK. 

8. �To save a copy, click Save As, give the 
file a name, and select the location 
where you would like to store the file. 

9. �Click Save. 

Cerner Customer Support
800-277-7330

Cerner
(version 2018.08.05)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Log into the BI Launch Pad.

2. �Under My Applications, click on the 
Web Intelligence icon. 

3. �Click on the New icon, select Universe, 
and click OK. 

4. �Select Ad Hoc Reporting and click OK. 

5. �Drag and drop the following fields from 
the Ad Hoc Reporting folders into the 
Results Objects box: 

	 a. �Diagnosis Code 
	 b. �Physician-Attending
	 c. �Diagnosis Description 
	 d. �Appointment Status-Short 
	 e. �Birth Date 
	 f. �Encounter Identifier 
	 g. �MRN-Organization 
	 h. �Financial Number 
	 i. �Person Name-Full 

6. �Drag and drop the following fields from 
the Ad Hoc Reporting folders into the 
Query Filters box: 

	 a. �Scheduling Location 
	 b. �Appointment Status-Short 
	 c. �Person Name-Last (if you want to 

exclude test patients) 
	 d. �Diagnosis Code 
	 e. �Diagnosis Type 

7. �Set the Scheduling Location to In List 
with a Prompt. 

8. �Set the Appointment Status-Short to 
In List with Values From List set to 
Checked Out; Checked In. 

9. �Set Person Name-Last to Different from 
Pattern with Constant set to your test 
patient last names (e.g., TEST, ZZTEST, 
etc.). 

10. �Set Diagnosis Code to In List with 
Values From List set to K74.3.

11. �Set Diagnosis Type to In List with 
Values from List set to FINAL; 
DISCHARGE.

12. �Assign Security to the appropriate 
PowerChart positions.

13. �Save the report as Primary Biliary 
Cholangitis Report/ICD-10 Code K74.3 
or other descriptive name.

14. �Publish the report to the Reporting 
Portal. 

Cerner Customer Support
800-277-7330

Cerner RW
Report Writers

(version 2018.08.05)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Select Registry from the upper-left navigation menu. 
NOTE: The Reports>Report Console will also get you there. 

2. �Select the Large R for Registry. 

3. �Click on the Demographics tab.

4. �Select the parameters you want to include in your report. 
NOTE: You can select multiple Primary Care Providers or multiple Ren Providers; you can select only 
one facility for each report. Your report will run faster the more you narrow your parameters. 
NOTE: Once your patient population is identified as registry enabled in their demographics, you can 
select Registry Enabled to quickly select your patient population.

5. �Click the Run New button. Then click the OK button. 

6. �Click the ICD tab. 

7. �In the box labeled ICD Codes, type the ICD-10 code K74.3 for Primary Biliary 
Cholangitis (PBC), then select all diagnoses that you want to include. 

8. �Select the radio button for Search in Assessments.  
NOTE: This will broaden your search to ensure all qualified patients are identified.

9. �Select a date range. 

10. �Click the Run Subset button. Results will display. From this page you can select 
actions you wish to take on this report. 
NOTE: Complete the following additional steps if you wish to save your report to Excel. Select Analyze 
Data; click Copy to save into Excel; and, from the top menu, click File>Save to save to desired location. 

11. �Click Save Query.

12. �In the popup window, Save Registry Query Report, and type in the name for your 
report.

13. �Select Prompt for Date Range. 
NOTE: If you want eligible patients to have an alert on their records to remind the provider, select the 
CDSS Enabled box.

14. �Click OK. You can find your saved query under the tab Saved Reports.

eClinicalWorks Customer Support
508-475-0450

eClinicalWorks
(version 11.52.75.6)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Click the Reporting Workbench Favorites hyperlink at the top of your Reporting 
Homepage (or via My Reports on the main toolbar). Reporting Workbench opens to My 
Reports tab.

2. �Select the Library tab. Be sure that Reports I Own, Reports I Ran Recently, and 
Reports I Am Subscribed To are shown.

3. �If no reports are seen, go to the Library and search Find Patients – Generic Criteria.

4. �Select + New Report.

5. �Give the report a name (e.g., “Practice Name Patients with PBC Diagnosis ***”).

6. �In the Patient Base field enter: My Patients 
NOTE: Multiple options are available to define the patient population for your report. Depending upon 
your system setup, you may choose a different option to best define your patient population. If none of 
the available options capture your desired patient population, your system administrator can create a 
patient base filter specific to your practice.

7. �In the Find Criteria field, search for Diagnosis.

8. �In the Diagnosis field, add the appropriate diagnosis code(s).

9. �Make sure your Report Logic is AND.

10. �Select the Display tab. 
NOTE: All the columns available for the report appear in the Available Columns list; columns that 
currently appear in the report are in the Selected Columns list.

11. �Select the following columns from the Available Columns list and click the right 
arrow to move them to the Selected Columns list. 
a. �Patient Name
b. �Patient MRN
c. �Patient Age
d. �Patient Sex

12. �Click Save.

13. �Click Run. Your report results will appear on the Detail List. 
NOTE: From the Explore tab you can filter, slice, measure, and visualize your report results. 

Epic Customer Support
608-271-9000

EpicCare Ambulatory
(version May 2022)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Click on Chart Reports on the left navigation panel.

2. �Select Inquiries.

3. �In the Find dropdown, select Patients.

4. �In the Where dropdown, select Problem Code ICD-10, Any. After selecting this, click 
the next dropdown and select Contains.

5. �Type in K74.3* (ICD-10 Code for Primary Biliary Cholangitis).

6. �Click Add.

7. Click Count (this will show the number of patients).

8. �Click Search (this will allow you to see who the patients are). After clicking Search, 
the report will automatically load.

GE Centricity Customer Support
866-281-7545

GE Centricity
(version 9.8-12.x)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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	1.	From the home screen, go to Medical Charts.

	2.	Click the Right Arrow (>) to expand the tab.

	3.	Select Advanced Search.

	4.	Choose your desired filters, such as Date Range and Problem Diagnosis.

	5.	Go to the Problems tab to the right and select the Plus Sign (+). 

	6.�	Select PBC (Primary Biliary Cholangitis) from the list or search for PBC in the search 
window.

	7.	�Click Search. The System Will Generate a List of Patients that Meet Your Selected 
Criteria.

	8.	�To access the patient’s chart, right click on the patient’s name and select View Chart. 
This will take you directly to the patient’s chart.

gMed-gGastro Customer Support
866-459-4227 Option 2

(selecting option 2 will take you directly to Customer Support)

gMed-gGastro
(version v5.r1.1)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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	 1. �Select Intergy EHR from the upper 
toolbar.

	 2. �Navigate to Reports.

	 3. �Click on Select.

	 4. �Click on Clinical in the left menu.

	 5. �In the Name contains text box, type in 
Clinical Analysis.

	 6. �Under Report Name, select Clinical 
Analysis Report.

	 7. �Click Run.

	 8. �Under Sort by, select the radio button 
for Patient or Provider.

	 9. �Under Service Dates, in the Range 
drop-down box: 

		  a. �Select Custom Date.
		  b. �In the text fields From and To, type 

desire date range (e.g., 09/05/2018 
and 09/05/2022).

	10. �Under Diagnosis,
		  a. �Click on radio button for Select.
		  b. �Click on Diagnoses button.
		  c. �Under Diagnosis Type, check ICD-9 

or ICD-10.
		  d. �In text field Search description, 

code or class, type 571.6 (ICD-9) or 
K74.3 (ICD-10).

		  e. �Under All Diagnosis Codes, select 
the diagnosis listed and click on 
Select.

		  f. �Click on OK.

	11. �Under Patients, please mark the 
following:

		  a. �Patients is automatically set to All 
Patients. 

		  b. �Providers is automatically set to 
All Providers. You can filter further 
to specific providers if desired by 
clicking the Providers button and 
selecting the desired providers. 

		  c. �Under Zip Codes, select the radio 
button All or Range; choose the 
specific filters as needed.

		  d. �Under DOB, select the radio button 
All, Date, or Age; choose the specific 
filters as needed.

		  e. �Under Sex, select the radio button 
All, Male or Female.

		  f. �Please check the following desired 
filters if needed: 

			   • �Include Deactivated Patients
			   • �Include Deceased Patients
			   • �Page break by Provider

	12. �Click Run.

	13. �In the pop-up box, select View, Print, 
or Send to File.

	14. �Click Run to display the report results.

Greenway Customer Service
877-932-6301, Option 2

(selecting Option 2 will take you directly to Customer Support)

Greenway Intergy
(version 12.50.00.03)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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	 1. Select Reporting from the upper toolbar. 

	2. Click on Report Selection.

	3. Click on Custom Reports in the left menu.

	4. Under Chart, select Clinical-Patient Listing.

	 5. �Under Reports, select Patient with Diagnosis X and Last Visit Date is Between X  
and X.

	6. Click Current Report Filters.

	 7. Under Field Name, in the drop-down boxes: 
		  a. In row one, select Diagnosis: Document Diagnosis.
		  b. In row two, select Date: Last Visit Date.

	8. Under Operators, in the drop-down boxes:
		  a. In row one, select Match any Value in List.
		  b. In row two, select Is Between.

	9. Under Match Value:
		  a. In row one, click Edit Match List hyperlink.
		  b. In the text field, type 571.6 (ICD-9) or K74.3 (ICD-10)
		  c. Click Add. 
		  d. Click OK.
		  e. In row two, type desire date range (e.g., [09/05/2018] and [09/05/2022]). 

	10. Click OK.

	11. �In the left menu list under Actions, click Immediate to display the report results or 
click Background to have report sent via email.

Greenway Customer Service
877-932-6301, Option 2

(selecting Option 2 will take you directly to Customer Support)

Greenway PrimeSuite
(version 18.00.02.06)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �Click on the Reports tab of your Menu Bar.

2. �From the patient’s chart, go to Reports on the Menu Bar. 

3. �Select problem item from the Problems List in the Selection Criteria dropdown.

4. �Type in Primary Biliary Cholangitis OR the ICD-10 code K74.3.* The Operator Window 
appears. Select Equals and click OK.

5. �Enter Provider ID and click OK.

6. �Select the report and click Run. 
NOTE: Complete extra step below if desired.

7. �Select a destination folder to save the report.

McKesson Customer Support
855-625-6285

McKesson Practice Partner
(version 11.4)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �On the Main Menu, locate the Menu Icon in the upper left-hand corner.

2. �Select External Links.

3. �Click Portal Reports.

4. �Browse Other Reports and Create a New Report.

5. �Find Search Criteria and select conditional arguments (such as contains or equals).

6. �Input Primary Biliary Cholangitis (ICD-10 Code K74.3*) in filter.

7. �Click Run Report.

Meditech Customer Support
781-821-3000

Meditech Expanse 
(Service Release 13)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 
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1. �From the NextGen top toolbar, click on 
File and then Select Reports>Generate 
Report>by Enterprise. The report filter 
window will launch. The Columns option 
is defaulted and displayed on the upper-
left corner.

2. �From this window, you can filter your 
report using the following criteria: 
a. �Highlight and click on the Provider 

option from the Settings List panel. 
You can include multiple providers 
or a single provider. Highlight the 
provider(s) name(s) and use the arrow 
to move the provider(s) to the right 
panel to include them in the report. 

b. �Click on the box with the ellipsis (3 
dots) next to the Location field. Type 
the site location and select Search. 
The locations will appear. Move the 
location(s) you want from the left 
panel to the right panel to include 
them in your report. 

c. �Click OK.
d. �Click on Between and then select 

beginning and end dates for Enc Date 
Range. Click OK.

3. �Highlight and click on the Diagnosis 
options from the Settings List panel.
a. �Click on the box with the ellipsis. 

Type K74.3 and select Search. The 
list of diagnoses appears. Move the 
diagnoses of choice from the left 
panel to the right. Click OK.

4. �Highlight and click on the Columns 
option from the Settings List panel. 
Some fields are auto selected. Deselect 
all fields by right clicking in the window. 
Choose Deselect All. Choose the fields 
you desire for your report (e.g., last 
name, first name, ICD-10 code, provider, 
location, etc.).

5. �To rename the column, select the 
column you would like to rename by 
right clicking in the window. Choose 
Rename Column; a curser will appear 
next to the column name. You can then 
rename it.

6. �Highlight and click the Totals option 
from the Settings List panel. Check 
Count Records. This will tell you the 
number of records you will be pulling for 
your report. You may need to refine your 
report based on the count displayed.

7. �Click OK within the Report Filter window. 
The report will generate.

8. �Click on the floppy disk icon on the top 
tool bar to save and name the report. If 
you want to run this report in the future, 
go to File>Select Report>Reports List to 
retrieve your saved reports. 
NOTE: from the top toolbar the user can also 
filter, modify, print, and export reports.

NextGen Customer Support
877-523-2120

NextGen
(version 6.2021)

*�For patients in your practice diagnosed with PBC prior to September 2015, you may need 
to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 



1. �Navigate to Reports from the Clinical Reporting options. Select Patient Lists Report 
New.

2. �From the All Patients dropdown, select Active Patients Only.

3. �From the Add Criteria dropdown, select Diagnoses.

4. �Enter Primary Biliary Cholangitis (PBC) OR ICD-10 code K74.3* and Date Range.  
NOTE: Leaving the date blank shows an all-time patient list for the diagnosis, but may take additional 
time to generate.

5. �After selecting all desired criteria, select Run Report. 
NOTE: Complete extra step below if desired.

6. �User has the ability to print or export the report to a .csv file and save it on a disc.

Practice Fusion Customer Support
415-346-7700

Practice Fusion 
(version 3.72)
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*�For patients in your practice diagnosed with PBC prior to September 2015, you may need to search using the ICD-9 code of 571.6 (primary biliary cirrhosis).6 


